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INTRODUCCIÓN 

 

En conversación con varios docentes de la Facultad se concluye que el Ingeniero 

financiero de Hoy tiene la necesidad de conocer y usar herramientas de última tecnología 

para tomar decisiones de calidad en su campo laboral con altos niveles de confianza. 

Después de varias visitas al Laboratorio Financiero encontré un software del que dispone la 

universidad y que es actualmente aplicado en las finanzas de muchas empresas en el 

mundo: El “Crystal Ball”. 

La necesidad de ofrecer un valor agregado para el desempeño laboral y profesional con 

el manejo de ésta herramienta de última tecnología que es usada por empresas de todos los 

tamaños de múltiples sectores tanto en empresas públicas como oficiales de USA, Europa y 

América Latina. Esta herramienta ofrece estadísticos, gráficos, pronósticos, escenarios, 

análisis de datos, estimaciones con altos niveles de confianza, cálculos con supuestos, 

técnicas avanzadas para la simulación de riesgos, etc.  Todo esto con el fin de minimizar el 

riesgo en las operaciones de evaluación, inversión y cobertura de una manera técnica. 

Durante éste Proyecto se va a estudiar la operatoria del “Crystal Ball” su uso y 

aplicaciones: En el campo Corporativo; para la Evaluación de un Proyecto, en el campo de 

Inversiones para la evaluación de la rentabilidad de un portafolio de inversión y la 

valoración de una opción sobre una acción, teniendo en cuenta para éstas aplicaciones las 

teorías y modelos técnicos, usados en la actualidad financiera internacional y así evaluar las 

aplicaciones del “Crystal Ball” como herramienta técnica-académica en casos aplicados 

para la rápida y acertada toma de decisiones con altos niveles de confianza. 
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OBJETIVOS 

 

Objetivo General 

 

Estudiar el funcionamiento del Cristal Ball su uso y aplicaciones en las Finanzas 

Corporativas, en la evaluación de un proyecto y en las Inversiones para la estructuración de 

un portafolio y la valoración de opciones en un entorno académico. 

 

Objetivos Específicos 

 

• Estudiar el funcionamiento y operatoria del Cristal Ball a través de los manuales y 

ejemplos del programa.  

• Analizar la aplicación del Crystal Ball en la Evaluación de Proyectos del sector real 

para un caso propuesto.  

• Analizar un portafolio de inversiones con un caso aplicando para el Crystal Ball. 

• Valorar una opción sobre una acción con el uso del Crystal Ball con el modelo 

Black-Scholes. 
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CONCEPTOS PREVIOS 

 

Variables Aleatorias 

 

Una variable aleatoria se define asignando un valor numérico a cada suceso simple de 

un experimento que conduzca a resultados aleatorios. Un ejemplo de una variable aleatoria 

es el número de cursos que durante un semestre específico realizó cualesquiera de 100 

estudiantes universitarios. El número de cursos varía entre 1, 2, 3, 4, o 5 de un estudiante a 

otro. Más ejemplos de variables aleatorias son: el número de niños por familia, el número 

de llamadas telefónicas por minuto en una compañía, el número de cotizaciones mensuales 

productivas de un contratista.  

Las variables aleatorias se clasifican en: 

 

Variable Cualitativa 

 

Es aquella que corresponde a una característica poblacional que no es numérica. Se 

clasifican en: 

Variables Nominales. Son aquellas que se pueden agrupar sin poseer ningún tipo de 

jerarquía entre sí: Sexo de las personas, la raza, etc. 

Variables Ordinales. Son aquellas que pueden ordenarse de acuerdo a algún criterio: 

Nivel socioeconómico, grados de desnutrición, etc. 

 

Variable Cuantitativa 

 

Es aquella que corresponde a una característica poblacional numérica. Se clasifican en: 

Variables Discretas: Son aquellas en la que el resultado sólo puede tomar valores 

enteros. Los datos que arroja surgen de un proceso de conteo: Número de alumnos en una 

Universidad, la cantidad de personas con vivienda. 
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Variables Continuas: Son aquellas que pueden adoptar infinitos valores entre dos 

enteros. Los resultados surgen de un proceso de medición: La altura, el peso, el nivel de 

colesterol. 

 

Variable Aleatoria Discreta 

 

Es una variable que puede tomar sólo valores de un conjunto predeterminado.  

 

Variable Aleatoria Continua 

 

Puede tomar cualquier valor dentro de un intervalo. Tal variable se mide en una escala 

numérica, es decir proporciona datos medios ya sea en escala de intervalos o de razón. 

Cada observación de la variable aleatoria puede tomar cualquier valor dentro de un rango 

específico. 

Al manejar una variable aleatoria continua, se busca la probabilidad de que la variable 

caiga dentro de un intervalo específico, en lugar de buscar la probabilidad de que la 

variable tome un valor específico. Las siguientes dos preguntas ilustran la diferencia entre 

variables aleatorias discretas y continuas. 

¿Cuál es la probabilidad de que el número de personas que pasen por la caja registradora 

durante los próximos 30 segundos sea exactamente 2? 

¿Cuál es la probabilidad de que la vida útil de un interruptor electrónico esté entre 4 y 6 

años? 

La primera pregunta sugiere el uso de una distribución de probabilidad discreta (un 

número entero: dos) y la segunda sugiere una distribución de probabilidad continua pues es 

posible 4.35 años y 4.58 años. 
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PROCESO DE SIMULACIÓN CON CRYSTAL BALL 

 

Etapas Del Proceso De Simulación 

 

Etapa Previa. 

- Formulación  del problema. 

- Obtención de información, datos, precios, etc. 

- Se construye un modelo en una hoja de cálculo de Excel que de solución al 

problema. 

 

Preparación de la Simulación. 

- Se definen las variables supuesto, decisión y de pronóstico. 

- Identificar el tipo de distribución de probabilidad con el uso  de la galería de 

distribuciones. 

- Se definen las condiciones de la simulación. 

 

Ejecución del Experimento. 

- Se corre la simulación Run. 

- Se Generan los Reportes y se presenta el Análisis. 

 

Ejemplo 1: Evaluación De Un Proyecto Para Dulces “La Abeja” 

 

Dulces “La Abeja”, prestigiosa compañía especializada en la producción de dulces 

típicos, mediante procesos artesanales, ha completado el desarrollo preliminar de un nuevo 

producto llamado “Brevas con Arequipe”. Éste producto se podrá desarrollar 

completamente y podría ser lanzado al mercado el próximo año si el Ministerio de Salud  

aprueba el producto. Aunque el producto parece tener mucha acogida, se tiene mucha 

incertidumbre acerca de las ventas que realmente se puedan generar y la manera como esto 

puede impactar en la inversión en desarrollo, licenciamiento, lanzamiento, mercadeo y 
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venta del producto. Debido a que se ha invertido y se espera invertir una importante suma 

de dinero, Dulces “La Abeja”, ha decidido utilizar Crystal Ball para apoyar la decisión de 

abandonar o desarrollar totalmente el proyecto. 

Hasta la fecha ha invertido Dulces “La Abeja”, $20.000.000 en el desarrollo inicial del 

proyecto. 

El proyecto tiene las siguientes fuentes de incertidumbre: 

Tasa de Crecimiento de la Demanda: Según estudios realizados por el departamento de 

mercadeo de Dulces “La Abeja”, se espera que el mercado aumente entre un 5% y 8% con 

el lanzamiento de “Brevas con Arequipe”. 

 Según la información reportada por el Banco de la República, se espera que el IPC para 

los próximos 5 años esté entre 4.5% y el 5,5%. Cualquier valor entre este intervalo tiene la 

misma probabilidad de ocurrencia.  

Penetración del Mercado: Según el departamento de mercadeo, la penetración del 

mercado mensual se proyecta de acuerdo al siguiente cuadro: 

 

PENETRACIÓN DEL MERCADO 

ENERO 11,0% 

FEBRERO 6,0% 

MARZO 4,5% 

ABRIL 5,0% 

MAYO 5,5% 

JUNIO 7,0% 

JULIO 8,0% 

AGOSTO 9,0% 

SEPTIEMBRE 9,0% 

OCTUBRE 7,0% 

NOVIEMBRE 6,0% 

DICIEMBRE 12,0% 

 

Tabla 1.  Comportamiento penetración del mercado.  
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Se debe calcular La Media y La Desviación Estándar. 

Los Costos del Periodo de Prueba: Dulces “La Abeja”, considera que los costos de 

prueba están entre $ 23.000.000 y $28.000.000. Cualquier valor entre este intervalo tiene la 

misma posibilidad de ocurrencia. 

Los Costos del Mercadeo: Dulces “La Abeja”, planea gastar una cantidad grande en 

mercadeo si el Ministerio aprueba el producto. Ellos esperan emplear una fuerza grande de 

ventas, buscando llegar a todos los rincones del país. Se espera gastar $ 26’000.000 que 

puede variar en un 10% más o un 10% menos. 

El coordinador de Mercadeo y Ventas de Dulces “La Abeja”, quiere saber cual es la 

probabilidad de lograr una ganancia mínima de $20.000.000 dado que la empresa puede 

hacer otra inversión que le generará un 15% de rentabilidad anual. 

 

Características De La Simulación 

 

Realice 10.000 ensayos para la simulación. 

Mercado para el producto: 300.000 personas con incrementos anuales según la 

penetración en el mercado. 

Ganancia por Unidad  (Caja de 12): $ 2.700 con incrementos mínimos esperados según 

el comportamiento del índice de precios al consumidor proyectado. 

Impuesto de Renta 38.5%. 

 

Operatoria Del Crystal Ball 

 

Solución del Ejemplo 1: Evaluación del Proyecto; Dulces “La Abeja” 

 

 

 Abrir Cristal Ball. En Windows, seleccione inicio > Todos los Programas 

Crystal Ball > Crystal Ball.  
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Figura 1. Método para abrir CB. 

 

Abre automáticamente Excel con nuevos íconos que son las aplicaciones del Cristal. 

 

 

 

Figura 2. Barra de herramientas CB.  
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Construcción de un modelo en una hoja de cálculo de Excel que de solución al 

problema. 

 

 

 

Figura 3.  Plantilla 1: Evaluación del proyecto.  

 

El modelo original demuestra que el proyecto es viable pues satisface los criterios 

establecidos de obtener la utilidad esperada incluso por encima de los  

$ 20.000.000. Es tarea del Crystal Ball establecer la probabilidad de lograr dicha 

ganancia.  

Para ello abordamos la etapa II: Preparación de la Simulación. Para los cual se hace 

necesario definir las variables supuesto, de decisión y de pronóstico, identificar el tipo de 

distribución de probabilidad con el uso  de la galería de distribuciones y definir las 

condiciones de la simulación.  
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En nuestro ejemplo, con el ánimo de establecer la probabilidad de que efectivamente se 

dé la utilidad esperada, el modelo tiene tres variables inciertas; Costo del periodo de 

prueba, Costo del Mercadeo y Penetración en el Mercado. 

 

Menú Define. 

 

 

Figura 4. Menú Define.  

 

Contiene las órdenes que me permiten definir y seleccionar las variables supuesto, 

decisión y pronóstico; también me permite  copiar, pegar y borrar los datos de Crystal Ball 

y por último me permite definir las preferencias de las celdas. 

 

Variables Supuesto 

 

Variables Supuesto: Son aquellas que dependen de la 

naturaleza y que son susceptibles a comportarse de acuerdo 

con una distribución probabilística. Por ejemplo; precio de 

compra o de venta de un activo o materia prima, tasa de 

crecimiento de la productividad, costos de penetración en un 

mercado, etc. Cristal las distingue con el uso del color verde y 

requieren de una celda con un número, no con formulas ni 

texto. Sólo este tipo de variables usan la galería de 

distribuciones de probabilidad. 

Para el Ejemplo: Las 

Variables Supuesto serán; 

promedio de penetración en el 

mercado (Distribución 

Triangular), tasa de crecimiento 

de la demanda o del mercado 

(Distribución Uniforme), e 

inflación (Distribución 

Uniforme). 
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Escoja una celda. Nos paramos en B9. 

Seleccione el menú Define > Define Assumption.   

 

 

Figura 5. Definiendo variable supuesto.  

 

Se escoge de la galería de distribuciones, la distribución triangular dadas las 

características de la variable, pues posee un máximo, un mínimo y un valor muy probable. 

Más adelante en éste documento se presenta en forma detallada las condiciones de una 

variable para escoger una distribución en particular. 

Las Variables Supuesto serán; promedio de penetración en el mercado (Distribución 

Triangular), tasa de crecimiento de la demanda o del mercado (Distribución Uniforme), e 

inflación (Distribución Uniforme). Se distinguirán con el color verde. 
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Figura 6. Definiendo tipo de distribución.  

 

Name: Se escribe el nombre para el pronóstico, puede contener hasta 40 caracteres y no 

se pueden utilizar los caracteres especiales +, -, *, /, >, <, =, etc. Promedio de penetración 

en el mercado. 

Clic en OK. 

Ahora aparece la Variable Supuesto, promedio de penetración en el mercado de color 

verde. Se usa la distribución triangular porque sus datos presentan un valor mínimo 4.5%, 

un valor máximo 12%, y un valor probable 7.5% – la media- . 
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Figura 7. Forma de insertar datos distribución triangular.  

 

 

 Figura 8. Variable supuesto insertada en la celda.  
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Repita todos los pasos anteriores para definir las otras variables supuesto del modelo.  

 

Figura 9. Variable supuesto insertada en todos los períodos.  

 

Las Variables Supuesto tasa de crecimiento de la demanda o del mercado Distribución 

Uniforme, Probabilidad de que el mercado aumente entre un 5% y un 8% e inflación 

Distribución uniforme también, dado que la probabilidad de que el evento se dé es la 

misma. 
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Figura 10. Crecimiento de la demanda.  

 

 

Figura 11.  Variable supuesto distribución uniforme, crecimiento de la demanda 

insertada en la celda.  
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A continuación se muestra como debe quedar la plantilla con las variables supuesto. 

 

 

Figura 12.  Variable supuesto distribución uniforme, crecimiento de la demanda 

insertada en las celdas.  

 

Variables de Decisión 

 

Variables de Decisión: Son aquellos datos sobre los 

que uno posee el control y la decisión de cambiarlos.  

Por ejemplo; tasa de descuento, días de inventario,  

etc. Cristal las distingue con el color amarillo y  

requieren de una celda con un número, no con  

formulas ni texto. 

Para el Ejemplo: Las  

Variables de Decisión 

serán, Costo del Periodo de 

Prueba entre 23 y 28 millones 

y Costo de Mercadeo 23.4 y 

28.6 millones. 

 

Escoja una celda. Nos paramos en B15. 

Seleccione el menú Define > Define Decision.  



Aplicaciones Del Software “Crystal Ball” 

En Las Finanzas Corporativas E Inversiones 

26 

 

Figura 13.  Definiendo variables de Decisión.  

 

 Name: Se escribe el nombre de la variable, puede contener hasta 40 caracteres y no se 

pueden utilizar los caracteres especiales +, -, *, /, >, <, =, etc. Costo del Periodo de 

Prueba. 

Lower: Es el límite más bajo de la variable, por defecto corresponde al 90% del valor de 

la celda. Puede escribirse otro valor de acuerdo a las características. 

Upper: Es el límite más alto de la variable, por defecto corresponde al 110% del valor 

de la celda. Puede escribirse otro valor de acuerdo a las características. 

Type: Se define el tipo de variable, si es una variable continua o discreta. 

 

 

Figura 14. Insertando datos variable Decisión. Costo de períodos de  prueba.  



Aplicaciones Del Software “Crystal Ball” 

En Las Finanzas Corporativas E Inversiones 

27 

Haga click en OK. 

Retorna a la hoja de cálculo y la celda aparece de color amarillo.  

Repita todos los pasos anteriores para definir las otras variables decisión del modelo.  

Se repiten todos los pasos para Costo de Mercadeo entre de $ 26’000.000 al año con una 

variación del 10% más o 10% menos, es decir que ésta inversión puede variar entre $ 

26’400.000 y $ 28’600.000. 

 

 

Figura 15. Insertando variables de Decisión en las celdas de proyección de costo de 

mercadeo.  

 

A continuación se muestra la plantilla con las variables supuesto y decisión. 
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Figura 16. Se han definido e insertado todas las variables de decisión.  

 

Variables de Pronóstico 

 

Variables de Pronóstico: Son aquellas variables a 

pronosticar, contienen la formula referente a la 

solución del modelo, mediante la incorporación de las 

variables supuesto y decisión. Son las variables 

objetivo como Ganancias, VPN, etc. 

Para el Ejemplo: La 

Variable Pronóstico será, el 

Valor Presente Neto del 

Proyecto. 

 

Escoja una celda. La celda que contiene la ganancia o pérdida del proyecto. 

Seleccione Define > Define Forecast 

Aparece el dialogo “Define Forecast”.  
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Figura 17.  Definiendo variable pronóstico.  

 

Name: Se escribe el nombre para el pronóstico, puede contener hasta 40 caracteres y no 

se pueden utilizar los caracteres especiales +, -, *, /, >, <, =, etc. Valor Presente Neto. 

Units: Corresponde a las unidades de medidas del pronóstico. $, %, etc. 

 

 

Figura 18. Método de inserción de datos variable pronóstico VPN.   

 

Seleccionar More > Aparece el cuadro de preferencias y definición de la variable 

pronóstico 
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Forecast Windows: Pronóstico. 

View: se encuentran diferentes formas de visualización. 

Window: con la opción Show automatically, se puede visualizar la ventana de 

simulación de la variable supuesto, ya sea durante la simulación o una vez se haya 

terminado la simulación. 

No son indispensables para correr la simulación. 

Precision: En esta opción se manejan escenarios del control de la precisión en los datos 

estadísticos. Se debe seleccionar a cual o cuales medida estadística el programa verificara la 

precisión indicada, sea a la media, la desviación Standard o el percentil. 

Filter: En esta opción, usted puede definir los valores del rango del pronóstico y Crystal 

Ball incluirá o desechara los valores del rango establecido. 

El rango mas utilizado, es incluir los valores entre (menos) – Infinito a (mas) + Infinito. 

Auto Extract: Esta opción permite especificar que datos estadísticos de la variable 

sobresalen automáticamente después de terminada la simulación. 

Haga click en OK. 

Una vez se establecen algunos parámetros, se selecciona OK y automáticamente se 

retorna a la hoja de cálculo y la celda VPN aparece de color azul. 

Repita todos los pasos anteriores para definir las otras variables pronóstico del modelo. 
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Figura 19. Se ha insertado la variable pronóstico en la celda.  

 

Ejecución Del Experimento. 

 

Pasamos a la siguiente etapa donde se corre la simulación Run. Se Generan los Reportes 

y se presenta el Análisis. 

 

Menú Run. 

 

 

Figura 20. Menú Run.  
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Contiene las órdenes que me permiten iniciar, parar, continuar y restaurar la simulación. 

También contiene las herramientas adicionales como el OptQuest (Cálculos de 

Optimización), CB Predictor (Pronostica Series de Tiempo) y las opciones Avanzadas 

como el Batch Fit, la Matriz de Correlación, etc. 

Adicionalmente, con la opción Run Preferentes, se pueden definir las condiciones o 

preferencias de la simulación. 

 

Corriendo La Simulación 

 

Condiciones o preferencias de la simulación. Se pueden cambiar y establecer las 

condiciones o preferencias para desarrollar el proceso de simulación. 

Seleccione Run > Run Preferences. 

Haga click en el menú que se desea establecer o cambiar. 

Trials: Se define el número total de ensayos a realizar por Crystal Ball, se establece la 

posibilidad de detener la simulación cuando exista un error matemático como por ejemplo, 

la división por cero. Adicionalmente se puede establecer un intervalo de confianza. 

 

 

Figura 21. Definiendo las preferencias de la simulación.  

 

Sampling: En la opción Use same seguence of random number, se activa la 

generación de números a la azar, permitiendo mayor acercamiento resultado tras resultado, 

cada vez que se repite la simulación. Generalmente se utiliza 999. Adicionalmente, se 

puede seleccionar el método estadístico de muestreo a utilizar. Generalmente se utiliza el 

método de Monte Carlo. 
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Speed: Se puede establecer la velocidad de la simulación, velocidad extrema, velocidad 

normal o velocidad de demo. Adicionalmente, se puede establecer la visualización del 

mapa del pronóstico una vez se corre la simulación. A menos segundos establecidos, mejor 

se observaran los cambios en el mapa del pronóstico. 

Options: En esta opción se establece principalmente la posibilidad de activar los datos 

de las variables supuesto para su análisis, se habilitan las correlaciones establecidas y se 

habilita la posibilidad de observar durante y después de la simulación el cuadro de control 

de la corrida. 

 

 

Figura 22. Definiendo las preferencias de la  simulación con todas las variables.  

 

Statistics: En esta opción se define el conjunto de datos sobre los cuales se calcularan 

los percentiles. Adicionalmente se establece el formato para los percentiles. 

98% Nivel de Confianza. 10.000 ensayos. Haga click en OK. 

Una vez se definen las variables supuesto, decisión, pronóstico y las preferencias 

condiciones de la simulación, el modelo esta listo para correr la simulación. 

Para correr la simulación, seleccione Run > Start Simulation 
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Figura 23. Icono de correr la simulación.  

 

Una vez se corre la simulación, Crystal Ball inicia el proceso automáticamente y 

aparecen el panel de control de la simulación y el gráfico del pronóstico, el cual resume los 

resultados de la simulación para cada variable pronóstico determinada. 

En el panel de control se puede tener acceso a las siguientes opciones: 

Run Preferences: Para modificar las preferencias de la simulación 

Start Simulation: Para correr nuevamente la simulación una vez restaurada. 

Reset Simulation: Restaura la simulación. 

Stop Simulation: Detiene la simulación. 

Estas opciones también se pueden activar por el menú Run. 

 

 

Figura 24. Gráfico simulación en proceso. 
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Gráfico de resultados. Éste gráfico se puede manipular. Deseo saber cual es la 

probabilidad de que el proyecto genere una utilidad mayor a cero. Voy al gráfico Ganancia 

o Pérdida del Proyecto y en la casilla inferior izquierda reemplazo con cero, y me da un 

nivel de certidumbre de 99.14% de que el proyecto sea rentable con un 98% de confianza 

en la simulación. 

 

Figura 25. Gráfico de resultado de la simulación.  

 

Aquí se muestra que haciendo la misma operación con $ 20’000.000, es decir, 

insertando $20000000 en la casilla inferior izquierda se concluye que la probabilidad de 

que el proyecto genere una utilidad superior a 20 millones es del 79.45% a un 98% de nivel 

de confianza. Es decir el proyecto es viable y vale la pena su ejecución. 
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Figura 26. Evaluando diferentes escenarios de la simulación.  

 

Menú Analyze 

 

 

Figura 27. Menú Analyze.  

 

Contiene las órdenes que me permiten crear una variedad de gráficos, reportes e 

informes para soportar el análisis y la toma de decisiones. Adicionalmente me permite 

guardar y restaurar los resultados de la simulación. 
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Crear el Reporte 

 

Seleccione Analyze > Create Report 

Aparecen el dialogo para definir las preferencias del reporte. Reports 

Assumptions: Se crea el reporte de las variables supuesto 

Decision Variables: Se crea el reporte de las variables decisión. 

Forecasts: Se crea el reporte de las variables pronóstico. 

Full: Se crea un reporte completo, involucrando las variables supuesto, decisión, 

pronóstico y todos los gráficos elaborados. 

Index: Se crea un reporte solamente con el nombre y la celda de ubicación de las 

variables supuesto, decisión y pronóstico. 

Custom: Me permite personalizar el reporte. 

Options: Esta opción me permite principalmente direccionar la localización del reporte, 

en un libro de Excel nuevo o como una hoja anexa al libro de trabajo. 

Adicionalmente, se puede asignar un nombre al reporte. 

 

Create Report > Full 

 

Figura 28. Creando el reporte.  
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El Gráfico Pronóstico 

 

Una vez se ha corrido la simulación, se puede visualizar el gráfico del pronóstico 

siguiendo los siguientes pasos: 

Analyze > Forecast Charts: Aparece el cuadro de dialogo en el cual selecciona la 

variable pronóstico de la cual se desea observar el gráfico. 

Haga click en Open. 

Número de Ensayos: Corresponde al número de ensayos realizados en la simulación. 

Rango de Despliegue: Es la distancia lineal entre el valor mínimo y máximo de los 

posibles resultados del pronóstico. Corresponde a un sub-rango del total de resultados, el 

cual contiene el 99% de los resultados posibles. 

Indicador de Certeza: Indica la posición del análisis de certeza. 

Nivel de Certeza: Muestra el grado de certeza o la probabilidad de los valores dentro de 

una gama de despliegue específica. La probabilidad de que se dé un evento dado. 

 

 

Menú Edit 

 

Copy Chart: Crea una copia de la distribución para ser pegada como una imagen en 

otros programas tales como word, excel, power point, Saint, etc. Las siguientes 

características solo se establecen para el gráfico de pronóstico seleccionado. 

Page Setup: En esta opción se configura la página para su impresión. 

Print Preview: Se observa previamente la página tal cual será impresa. 

Print: Se establecen las características de impresión y se ordena la impresión. 

 

Menú Forecast 

 

Open Sensitivity Chart: Se activa el gráfico de sensibilidad. 

Fit Probability Distribution: Se activa la distribución más adecuada que describe el 
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comportamiento del pronóstico. 

 

Menú Preferences¡Error! Marcador no definido. 

 

Este menú presenta las siguientes opciones principales: Forecast Preferences y Chart 

Preferentes. 

 

Gráfico comparativo – overlay 

 

Después de completar una simulación, se puede crear un mapa comparativo con 

determinados gráficos pronósticos, con el fin de observar sus características y comparar sus 

diferencias o similitudes. La observancia de estas diferencias o similitudes puede resultar 

difícil si se observan los gráficos pronósticos por separado. 

Como Crear un Gráfico Comparativo. El Gráfico Comparativo, solo se puede crear 

una vez se haya completado la simulación. 

Seleccione Analyze > Overlay Charts 

Aparece el dialogo Overlay Charts 

Seleccione New. 

Se adicionan al cuadro de dialogo todas las variables pronosticadas en el modelo. 

Seleccionar las variables con las cuales se creara el gráfico comparativo. 

Haga click en OK. 

Se crea el gráfico de comparación con los pronósticos seleccionados. 

Para visualizar un gráfico de comparación ya creado, se selecciona Analyze > Overlay 

Charts > Open 

En el siguiente dialogo, se puede crear un nuevo gráfico de comparación, abrir un 

gráfico ya creado, cerrar o borrar un gráfico. Se pueden crear tantos gráficos de 

comparación como se deseen, lo importante es trabajar variables que sean comparables, ya 

sea por sus características o por sus unidades de medida. 

Las opciones del menú, cumplen las mismas funciones explicadas para el gráfico de 

pronóstico. El aspecto adicional en el menú de opciones, radica en la posibilidad de rotar el 
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mapa de la comparación cuando se visualiza en tercera dimensión. 

 

Gráfico De Tendencia 

 

Después de completar la simulación se puede crear un gráfico de tendencia, por medio 

del cual se pueden observar en un solo gráfico la tendencia de certeza de las variables 

pronóstico. Para crear un gráfico de tendencia, es importante tener variables pronóstico que 

evolucionan en el tiempo, como por ejemplo, en la evaluación de proyectos de inversión, se 

puede tomar el flujo de caja 1, el flujo de caja 2, el flujo de caja 3, etc. Dicho gráfico carece 

de utilidad cuando se elabora con variables pronóstico estáticas. 

El Gráfico de Tendencia, solo se puede crear una vez se haya completado la simulación. 

Seleccione Analyze > Trend Charts 

Aparece el dialogo Trend Charts 

Seleccione New 

Se adicionan al cuadro de dialogo todas las variables pronosticadas en el modelo. 

Seleccionar las variables con las cuales se creara el gráfico de tendencia. 

Haga click en OK. 

Se crea el gráfico de tendencia con los pronósticos seleccionados. 

Cada banda representa el rango de certeza de los valores pronosticados, por regla 

general, el gráfico de tendencia determina la probabilidad de los pronósticos con respecto a 

su media. La certeza de cada banda, nos permite determinar que rangos del pronóstico 

tienen la mayor probabilidad de ocurrencia. 

Para visualizar un gráfico de tendencia ya creado, se selecciona Analyze > Trend 

Chart > Open 

En el siguiente dialogo, se puede crear un nuevo gráfico de tendencia, abrir un gráfico ya 

creado, cerrar o borrar un gráfico. 

Se pueden crear tantos gráficos de tendencia como se deseen, lo importante es trabajar 

variables que evolucionen en el tiempo, sino, carece de utilidad. 

Las opciones del menú, cumplen las mismas funciones explicadas para el gráfico de 

pronóstico.  
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Al igual que en el gráfico de comparación, el aspecto adicional en el menú de opciones 

radica en la posibilidad de rotar el mapa de tendencia cuando se visualiza en tercera 

dimensión. 

En algunas ocasiones, se puede presentar la posibilidad de que el software seleccione 

automáticamente las variables sin darle un orden lógico o adecuado, lo cual no enmarca una 

tendencia real. 

Este problema se puede solucionar mediante el siguiente procedimiento. 

En el gráfico de tendencia seleccione > Preferences > Chart > Chart Type 

En la opción Chart Series, se puede modificar el orden seleccionando cada serie de 

datos y dando click en las flechas, hasta tener el orden adecuado. 

 

Gráfico De Sensibilidad 

 

Una vez completada la simulación, analizados los gráficos de pronóstico, los gráficos 

comparativos y los gráficos de tendencia, se puede determinar como una determinada 

variable supuesto afecta el resultado del modelo. 

Para ello, se puede determinar el grado de sensibilidad del pronóstico para cada variable 

supuesto. Dicha sensibilidad parte de dos factores: 

La sensibilidad del pronóstico para cada variable supuesto 

La incertidumbre de la variable supuesto. 

El Gráfico de Sensibilidad, solo se puede crear una vez se haya completado la 

simulación. 

Seleccione Analyze > Sensitivity Charts 

Aparece el dialogo Sensitivity Charts 

Seleccione New 

Se adicionan al cuadro de dialogo todas las variables pronosticadas en el modelo. 

Seleccionar las variables con las cuales se creara el gráfico de sensibilidad. 

Haga Click en OK. 

Se crea el gráfico de sensibilidad con los pronósticos seleccionados. 

Los porcentajes, representan el efecto que produce cada variable supuesto en el resultado 
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del modelo, de tal forma que los porcentajes más altos, son aquellos que mas inciden en el 

modelo, mientras los porcentajes bajos o negativos tienen poca incidencia. 

Para visualizar un gráfico de sensibilidad ya creado, se selecciona Analyze > Sensitivity 

Chart > Open 

En el siguiente dialogo, se puede crear un nuevo gráfico de sensibilidad, abrir un gráfico 

ya creado, cerrar o borrar un gráfico. 

Se pueden crear gráficos de sensibilidad por cada variable pronóstico. 

Las opciones del menú, cumplen las mismas funciones explicadas para el gráfico de 

pronóstico. 

Para facilitar su comprensión, se puede modificar la visualización del mapa de 

sensibilidad. 

En el gráfico de sensibilidad seleccione Preferences > Chart > Chart Type. 

En la opción Chart Type seleccione: 

Bar Magnitude Pie también es posible seleccionar las variables supuestos con las 

cuales se desea crear un gráfico de sensibilidad. 

En el gráfico de sensibilidad seleccione Sensitivity > Choose Assumptions 

Seleccione las variables supuesto con las cuales se creara el gráfico de sensibilidad. 

Seleccione Analyze > Restore Results 

 

Guardar Y Abrir 

 

Para guardar o abrir un modelo, se pueden utilizar las mismas opciones del Excel.  

Para guardar los resultados de la simulación seleccione Analyze > Save Results  

Para abrir los resultados de la simulación. 
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La Barra De Herramientas Del Crystal Ball. 

 

 

Figura 29. Barra de Iconos CB.  

 

Para ayudar a establecer modelos en la hoja de cálculo y correr simulaciones, Crystal 

Ball posee una barra de herramientas que proporciona el acceso directo a la mayoría de 

funciones y opciones de cada menú. 

Se organizan de izquierda a derecha, los tres primeros grupos corresponden al menú 

Define; los cuatro siguientes íconos corresponden al menú Run y los últimos al menú 

Analyze.  

 

 

Figura 30. Barra de herramientas CB.  

 

Como Asignar Distribuciones De Probabilidad 

 

Cristal Ball le permite al usuario elegir entre 23 distribuciones de probabilidad según se 

ajuste al comportamiento de la variable aleatoria. El software presenta las Distribuciones: 
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(1) Normal, (2) Binomial, (3) Uniforme, (4) Triangular, (5) Geométrica, (6) 

Hipergeométrica, etc. 

Ubicarse en la celda que se quiere modelar. 

Ir a Cell en la barra de herramientas y escoger define assumptions. 

Escoger la distribución. 

Entrar datos y correr la simulación. 

 

Figura 31. Galería de distribuciones CB.  

 

Entrada De Datos Según La Distribución. 

 

A continuación se muestra la forma de entrar los datos en una distribución. 

 

Distribución Normal. Es la distribución más importante en la teoría de probabilidades 

porque describe muchos fenómenos naturales, tales como la altura de la gente, la tasa de 

inflación, el precio de la gasolina, etc. 
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Figura 32. Distribución normal.  

 

Es una distribución continua de probabilidad simétrica con forma de campana, tiene la 

misma forma a la derecha y a la izquierda de la media. El área total bajo la curva es igual a 

1 o 100% el 50% de los datos está a la derecha e infinito y el otro 50% de los datos está a la 

izquierda e infinito. 

Variables; la media, la mediana y la moda poseen el mismo valor. Condiciones, posee un 

valor muy probable de ocurrencia; la madia. La variable supuesto puede estar por encima o 

por debajo de la media. Parámetros; la media y la desviación estándar. 

Ejemplo entrada de datos Distribución Normal: Se proyecta que el índice de 

inflación más probable es del 4%, pero puede estar por encima o por debajo de dicho 

pronóstico. La dispersión de los datos históricos analizados con respecto a la media es del  

2%. 

Condiciones; posee un valor muy probable de ocurrencia, la media. El índice de 

inflación más probable es del 4%. La variable supuesto puede estar por encima o por debajo 

de la media. El índice de inflación puede estar por encima o por debajo del 4%.  

Media: 0.04 

Desviación Estándar: 0.02. 
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Figura 33. Distribución Normal, método de inserción de datos.  

 

Distribución Binomial. Es una distribución de probabilidad discreta que describe el 

número de veces en que ocurre un acontecimiento en un número fijo de ensayos como 

lanzar una moneda al aire varias veces para encontrar la probabilidad de caer cara o sello. 

Condiciones: Para cada ensayo sólo existen 2 resultados, Falso o Verdadero, Éxito o 

Fracaso. 

Los ensayos son independientes. 

La probabilidad de ocurrencia es la misma para cada ensayo.  

Probabilidad = Probabilidad de Éxito. 

Trials = Número de ensayos. 

Ejemplo entrada de datos Distribución Binomial: El director de Mercadeo de una 

importante empresa, quiere establecer el número de personas que prefieren el producto de 

la compañía. El director realizó una encuesta a 100 clientes y determinó que el 60% de 

ellos prefieren el producto de la compañía por encima del competidor. 

Condiciones: Para cada ensayo solo existen 2 resultados, falso o verdadero. Se prefiere o 

no se prefiere el producto. Los ensayos son independientes, lo que sucede en el primer 

ensayo no afecta al segundo, ni el tercero, etc.  
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La probabilidad de ocurrencia es la misma para cada ensayo. Probabilidad = 60%, Trials 

= 100  

 

 

Figura 34. Distribución Binomial.  

 

Distribución Uniforme. Existen distribuciones de probabilidad teóricas para variables 

aleatorias continuas, como las hay para variables aleatorias discretas. Las distribuciones 

Binomial y de Poisson son ejemplos de éstas últimas. La distribución uniforme es 

apropiada cuando se observan variables aleatorias continuas y cuando es igualmente 

probable que ocurran los resultados de una observación dentro de cualquier segmento de 

igual tamaño en el intervalo especificado.   

Es una distribución cuyos valores tienen la misma posibilidad de ocurrir. Se utiliza 

cuando usted conoce el rango y todos los datos tienen la misma probabilidad de ocurrencia 

100%. El área o probabilidad del rectángulo es igual a 1 o 100%.  

Condiciones; Valor mínimo, Valor máximo, Todo valor entre el mínimo y el máximo 

tiene la misma probabilidad de ocurrencia. 

Ejemplo entrada de datos Distribución Uniforme: Una empresa está interesada en 

comprar un software para mejorar su desempeño. Se estima que los gastos para la 

implementación de dicho programa está entre $ 500,000 y  
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$ 900,000. Los valores intermedios entre dicho rango tienen la misma probabilidad de 

ocurrir.  

 

 

Figura 35. Distribución uniforme.  

 

Distribución Triangular. La distribución triangular describe una situación donde usted 

Se conoce el valor mínimo, el valor máximo y el valor más probable de ocurrencia (el cual 

se debe encontrar entre el valor mínimo y el valor máximo). 

Ejemplo entrada de datos Distribución Triangular: El dueño de una estación de 

gasolina, necesita saber la cantidad de gasolina vendida la semana pasada. Los registros 

históricos por semana muestran un mínimo de 3.000 galones y un máximo de 7,000 

galones. Los registros también muestran que la mayoría de las semanas las ventas fueron de 

5,000 galones. 

 

 



Aplicaciones Del Software “Crystal Ball” 

En Las Finanzas Corporativas E Inversiones 

49 

 

Figura 36. Distribución triangular.  

 

Distribución Geométrica. Describe el número de ensayos necesarios hasta la primera 

ocurrencia exitosa.  

Condiciones: El número de ensayos no se establece como un dato fijo. Los ensayos se 

realizan hasta el primer éxito. La probabilidad de éxito es la misma para cada ensayo.  

La Distribución Geométrica tiene sólo un parámetro: La Probabilidad. 

Ejemplo entrada de datos Distribución Geométrica: Usted trabaja para una compañía 

de petróleos y necesita describir el comportamiento del proceso de perforación. Se sabe, de 

acuerdo a datos históricos que la probabilidad de éxito en la perforación es del 10%.  

El número de ensayos es ilimitado. El proceso de perforación continúa hasta que se 

encuentre petróleo. La probabilidad del 10% es la misma para cada proceso de perforación.  
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Figura 37. Distribución geométrica.  

 

Distribución Hipergeométrica. Es muy semejante a la distribución Binomial, ya que 

también describe el número de veces en que ocurre un acontecimiento en un número fijo de 

ensayos. En la distribución Binomial los ensayos son independientes. En la distribución 

hipergeométrica los ensayos son dependientes y la probabilidad cambia para cada ensayo 

dependiendo del resultado del otro.  

Condiciones: El tamaño de la población es un número fijo, debe ser menor o igual a 

1.000. El tamaño de la muestra (número de ensayos), representa una porción de la 

población. La tasa inicial de éxito que se conoce, cambia después de cada ensayo.    

Parámetros: 

Success = Tasa Inicial de Éxito. 

Trials = Tamaño de la Muestra. 

Population = Población. 

Ejemplo entrada de datos Distribución Hipergeométrica: Usted quiere describir el 

número de consumidores en una población fija que prefiere la marca X. Usted trata con una 

población total de 40 consumidores, de la cual 30 prefieren la marca X y 10 prefieren la 

marca Y. Usted inspecciona 20 de esos consumidores.   

Condiciones: 
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La población es de 40. 

El Tamaño de la muestra (20 consumidores), representa una porción de la población. 

Inicialmente, 30 consumidores prefirieron la marca X. Éste porcentaje cambia cada vez 

que se pregunta a los 20 consumidores de la muestra. 

 

 

Figura 38. Distribución Hipergeométrica.  

 

Distribución Lognormal. Se utiliza extensamente en las situaciones en las cuales los 

valores se sesgan positivamente, es decir, no pueden tomar valores negativos. Ejemplo, los 

precios de las acciones.  

Condiciones: La variable incierta puede aumentar sin limites, pero no puede tener 

valores inferiores a cero. La variable es sesgada positivamente, es decir, toma valores 

positivos.  

Parámetros: 

Media. 

Desviación Estándar. 

Ejemplo entrada de datos Distribución Lognormal: Usted posee una acción,  la cual 

se espera valdrá $ 70 al finalizar el año. Utilizando datos históricos se determina que la 

desviación estándar del precio de la acción es de $ 12.  
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Figura 39. Distribución Lognormal.  

 

Distribución Exponencial. Se relaciona con la distribución de Poisson, ya que ésta 

también describe el número de ocurrencias de un acontecimiento en un intervalo de tiempo.   

Se describe el tiempo entre las ocurrencias. La distribución no se afecta por los 

acontecimientos previos.  

Rate = Tasa. 

Ejemplo entrada de datos Distribución Exponencial: Una agencia de viajes quiere 

establecer el tiempo entre las llamadas telefónicas entrantes. En promedio, se reciben 35 

llamadas cada  10 minutos. 



Aplicaciones Del Software “Crystal Ball” 

En Las Finanzas Corporativas E Inversiones 

53 

 

Figura 40. Distribución exponencial.  

 

Como identificar la distribución que sigue una serie de datos. 

 

Los criterios del analista fundamentado en sus métodos y experiencia determinarán la 

distribución ideal según sea el caso. Cuando se tienen datos históricos, Crystal Ball analiza 

los datos por sí mismo mediante la herramienta Fit y selecciona la mejor distribución de 

probabilidad para el análisis de los datos según su comportamiento. Debe tenerse más de 15 

datos históricos. 
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Figura 41. Función FIT.  

 

Tomemos como ejemplo los rendimientos históricos del último año de la acción de 

Citigroup que cotiza en la bolsa de valores de Nueva York. 

Se abre la galería de Distribuciones y se selecciona Fit, Crystal abre un cuadro de 

diálogo donde le podemos insertar la serie de datos, click en Choose (donde escogemos las 

distribuciones de probabilidad deseadas para analizar), click en Chi-Square (por tratarse de 

un método muy preciso para pruebas de normalidad) y clic en OK. Crystal presenta su 

análisis acerca del comportamiento que siguen los datos y elige la distribución que mas se 

ajusta.    
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Figura 42. Corriendo la función FIT.  

 

Para seleccionar la distribución adecuada se deben seguir los siguientes pasos: 

Seleccione la celda donde se desea crear un supuesto, puede estar en blanco o debe 

contener solamente un número, no una formula. 

Seleccione Define > Define Assumption, aparece la Galería de Distribuciones 

Seleccione Fit… 

Escoja una de las siguientes dos opciones: 

Range: Si los datos históricos se encuentran en una hoja de trabajo en el mismo libro de 

excel, determinando el rango de las celdas de ubicación. 

Text File: Si los datos históricos se encuentran en un libro diferente al libro de trabajo. 

Dando click en Browse se determina la ubicación del archivo. 

Se especifica las distribuciones que se desean estudiar. 

All Continuous: Estudie todas las distribuciones continuas. 

Choose: Se seleccionan las distribuciones objeto del estudio. 



Aplicaciones Del Software “Crystal Ball” 

En Las Finanzas Corporativas E Inversiones 

56 

Normal: Estudia la Distribución Normal 

Especificar el método de estimación: Se tienen tres posibilidades, la prueba Anderson-

Darling, la prueba Chi-Square y Kolmogorou-Smirnov. La más utilizada es la Prueba 

Chi-Square, en español, Chi-Cuadrado. 

Haga clik en OK. 

Se inicia el proceso de selección y aparece el gráfico de las comparaciones.  

 

 

Figura 43. Análisis de datos función FIT.  

 

Aparecen en orden las distribuciones seleccionadas como las más adecuadas. 

Se puede observar el gráfico de las comparaciones dando clic en > Next Distribution. 
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Figura 44. Resultado del análisis función FIT.  

 

En el gráfico de muestra que la lista de datos de rentabilidades históricas del último año 

para la acción de Citigroup sigue una distribución t – Student. 

Dando Click en View > Statistics, podemos acceder a el análisis estadístico de la serie 

de datos con la media, varianza, desviación estándar, curtosis, etc. 
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Figura 45. Detalle de características de la distribución de probabilidad hallada.  
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EJEMPLO 2: EVALUAR LA RENTABILIDAD PARA UN PORTAFOLIO DE 

INVERSIÓN EN ACCIONES 

 

PORTAFOLIO DE ACCIONES 

 

Elabore una base de datos con los precios de 10 acciones. 

 

Realice un análisis estadistico y seleccione 4 acciones. 

 

Halle el rendimiento y la desviación del portafolio. 

 

Crystal Ball: Cual es la probabilidad que el rendimiento del portafolio se 

cumpla? 

 

Abrir Crystall Ball. 

Abrir el archivo de Excel con la plantilla que contiene el modelo del portafolio. 

 

Variables  Supuesto 

 

Variables Supuesto: Son aquellas que 

dependen de la naturaleza y que son 

susceptibles a comportarse de acuerdo con una 

distribución probabilística. Por ejemplo; precio 

de compra o de venta de un activo o materia 

prima, tasa de crecimiento de la productividad, 

costos de penetración en un mercado, etc. 

Cristal las distingue con el uso del color verde y 

requieren de una celda con un número, no con 

formulas ni texto. 

Para el Ejemplo: Las Variables 

Supuesto son el rendimiento 

promedio de cada activo (Media) 

celda O276, P276, Q276, R276. 

Usamos la distribución triangular 

siendo la media el más probable, el 

valor mínimo U282, V282, W282, 

X282 el mínimo y el valor máximo 

U283, V283, W283 X283 el máximo. 
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Figura 46. Definición variable supuesto portafolio.  
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Figura 47. Insertando características de las variables del portafolio a la distribución.  

 

Variables de Decisión 

 

Variables de Decisión: Son aquellos datos sobre los 

que uno posee el control y la decisión de cambiarlos. Por 

ejemplo; tasa de descuento, días de inventario, etc. 

Cristal las distingue con el color amarillo y requieren de 

una celda con un número, no con formulas ni texto. 

Para el portafolio: Las  

Variables de Decisión 

serán, el PESO asignado a 

cada activo. Celdas O278, 

P278, Q278, R278. 

 

 

Figura 48. Definiendo variables de decisión.  
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Variables de Pronóstico 

 

Variables de Pronóstico: Son aquellas variables a 

pronosticar, contienen la formula referente a la solución 

del modelo, mediante la incorporación de las variables 

supuesto y decisión. Son las variables objetivo como 

Ganancias, VPN, etc. 

Para el Ejemplo:  

La Variable Pronóstico 

será, O281 Rendimiento del 

Portafolio. 

 

 

Figura 49. Definiendo variable pronóstico.  

 

Establecer las preferencias de la simulación: 

10,000 ensayos. 

98% nivel de confianza. 

Correr la Simulación: Run > Start Simulation. 
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Figura 50. Corriendo la simulación para portafolio.  

 

La probabilidad de que el portafolio rente un 0.0010% en un día es de 55.36%. 

 

 

Figura 51. Resultados de la simulación para el portafolio.  
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Guardar los resultados. Analyze > Save Results. 

 

 

Figura 52. Método para guardar resultados.  
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EJEMPLO 3: VALORACIÓN DE UNA OPCIÓN CON EL MÉTODO BLACK 

AND SCHOLES CON LA SIMULACIÓN DEL CRISTAL BALL. 

 

El precio de la acción para Whirlpool Corp en la Bolsa de Valores de Nueva York tres 

meses antes del vencimiento de una opción es de 86.32 dólares, el precio de ejercicio de la 

opción es 80 dólares. 

Hallar el precio de la opción call y put con el diseño de una hoja de cálculo de Excel. 

Use los precios históricos de los dos últimos años de la acción en el mercado Spot para 

hallar la volatilidad y el rendimiento anual promedio. Para el tipo de interés libre de riesgo 

use la tasa de bonos del tesoro americano para el horizonte de la opción, tres meses. 

Pronóstico con Crystal Ball: Hallar la probabilidad de que el Precio el precio de la 

prima de la opción Call y de la Put calculado con la plantilla se cumpla. 

 

 

Figura 53. Información del mercado tasa bonos diferentes horizontes.  
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Figura 54. Precio de la opción CALL en el mercado.  

 

 

Figura 55. Precio de la opción PUT en el mercado.  
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Variable Supuesto: Distribución Lognormal para el Precio Spot dado que el precio de 

una acción siempre será mayor a Cero. Se requiere la media y la desvest. 

 

 

Figura 56. Definiendo la variable supuesto en la distribución.  

 

Figura 57. Entrando las características de la variable.  
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Variable de Decisión: Volatilidad. 

 

 

Figura 58. Definiendo la variable decisión.  

 

Variables Pronóstico: Precio de la Call y de la Put.  

 

Figura 59. Definiendo las variables pronóstico.  



Aplicaciones Del Software “Crystal Ball” 

En Las Finanzas Corporativas E Inversiones 

69 

 

 

Figura 60. Corriendo la simulación para los precios de la opción.  

 

La simulación concluye que hay un 76.30% de probabilidad de que la opción call tenga 

un precio de 4.93 y un 89.93% de que la opción put alcance un precio de $ 7. 
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CONCLUSIONES 

 

- El programa sirve básicamente para realizar análisis de sensibilidad y simulaciones 

sobre un modelo ya construido. Es una herramienta técnica muy interesante que 

complementa a Excel. 

- Crystal Ball aumenta significativamente el entendimiento de un proyecto,  mejora 

las proyecciones realizadas y hace el VPN o cualquier otro criterio de decisión más 

confiable. 

- Crystal permite identificar el comportamiento que sigue una serie de datos, sea 

normal, exponencial, lognormal, triangular, etc. 

- Dado que Cristal trabaja con simulación de montecarlo y probabilidades, su 

desempeño es limitado a ciertas áreas, por ejemplo la valoración de la opción, porque nos 

da la probabilidad de que un precio se cumpla y haría falta otros criterios para tomar una 

decisión de calidad. 

- Cristal es ideal para la evaluación de un proyecto pues aterriza todas las 

expectativas de las variables en estudio. Así saber que mi probabilidad de realmente 

ganarme $ 20’000.000 es del 90% me ayuda a tomar una desición de calidad o si dicha 

probabilidad es solo del 32%. 
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